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File Opening

These templates are designed to be used on a computer, PC (Windows) or Mac (macOS) using Microsoft Word. If you use another device (tablet,
iPad, smartphone, etc.) software, the template can undergo changes or alterations. These templates are compatible with Microsoft Word 2007 and later
versions.

You can download the files to a tablet but you must use a computer to edit them. | recommend downloading and editing the templates from a computer.
After unzipping your files from the archive, open the folder 1. Templates_(Word), select a suitable file, and then open it with MS Word.

The resume template is ready, usable and easy to edit - just replace the template text with your own information.

In this guide you will find graphic step-by-step instructions on how to produce a properly formatted resume.



Text Editing

After opening the file, you can start to replace the template text with your own information. For more detailed information on how to write a resume

correctly, please read our Resume Writing Guide.

Just select the text you want to replace and write your own text.

ROBERTA OSBORNE

PROFESSIONAL JOB TITLE

+012-345-6789 | name.surame@gmail.com | New York, NY | linkedin.com/in/name.surname

SUMMARY

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Cras eu tellus et enim omare feugiat id id lacus. Integer at
euismod erat. Nullam semper ante nec tempus pretium. Sed nisi lacus, blandit at scelerisque nec, imperdiet non
diam. Proin ut iaculis massa. Nulla non odio pharetra, gravida nunc eu, laoreet tortor. Donec vel risus metus. Nulla
sem orci, sollicitudin sed mauris eu, euismod mollis erat

JULIET ROWSE|

PROFESSIONAL JOB TITLE

+012-345-6789 | name.surname@gmail.com | New York, NY | linkedin.com/in/name.surname

SUMMARY

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Cras eu tellus et enim ornare feugiat id id lacus. Integer at
euismod erat. Nullam semper ante nec tempus pretium. Sed nisi lacus, blandit at scelerisque nec, imperdiet non
diam. Proin ut iaculis massa. Nulla non odio pharetra, gravida nunc eu, laoreet tortor. Donec vel risus metus. Nulla
sem orci, sollicitudin sed mauris eu, euismod mollis erat

Tip: If something goes wrong and you
want to go back, just press Ctrl+Z or
Cmd+Z. You can also click the Undo
button on the Quick Access Toolbar. If
you want to undo multiple steps, you can
press this key combination multiple

times. Clipboard
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JULIET ROWSE

PROFESSIONAL JOB TITLE

+012-345-6789 | name surname@gmail.com | New York, NY | linkedin.com/in/name surname

SUMMARY

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Cras eu tellus et enim ornare feugiat id id lacus. Integer at
euismod erat. Nullam semper ante nec tempus pretium. Sed nisi lacus, blandit at scelenisque nec, imperdiet non
diam. Proin ut iaculis massa. Nulla non odio pharetra, gravida nunc eu, laoreet tortor. Donec vel risus metus. Nulla
sem orci, sollicitudin sed mauris eu, euismod mollis erat. *

JULIET ROWSE

PROFESSIONAL JOB TITLE

+012-345-6789 | name surname@gmail com | New York, NY | linkedin com/in/name surname

SUMMARY

Vivamus at quam non odio finibus aliquet |

PROFESSIONAL SKILLS

| Communication | Negotiation | Collaboration | Build Relationship | Coaching | Market Knowledge |
| Sales Planning | Develop Budgets | Analytics | Meeting Sales Goals |

Tip: Also, don't forget to press Ctrl+S or
Cmd+S to save the changes. Another way
to save is to click the Save button on the Home
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Text Formatting

If you copy text from another file (for example, your previous resume), the formatting style will also be copied.

Below, you will find instructions on how to fix it.

1. Select a text with the correct style, and then press Ctrl+Shift+C or

Cmd+Shift+C to copy its format.

JULIET ROWSE

PROFESSIONAL JOB TITLE

+012-345-6789 | name sumame@gmail.com | New York, NY | linkedin.com/in/name.sumame

SUMMARY

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Cras eu tellus et enim ornare
feugiat id id lacus. Integer at euismod erat. Nullam semper ante nec tempus pretium. Sed

nisi lacus, blandit at scelerisque nec, imperdiet non diam. Proin ut iaculis massa. Nulla non odio pharetra,
0 gravida nunc eu, laoreet tortor. Donec vel risus metus. Nulla sem orei, sollicitudin sed mauris en, euismod
mollis erat.

PROFESSIONAL SKILLS

| Communication | Negotiation | Collaboration | Build Relationship | Coaching | Market Knowledge |
| Sales Planning | Develop Budgets | Analytics | Meeting Sales Goals |

WORK EXPERIENCE

Position Title Here 08/2019 - Present
Company, Location
Proin a magna condimentum eros feugiat iaculis. Interdum et malesuada fames ac ante ipsum primis in faucibus.
Aliquam auctor leo id ultrices euismod. Etiam eget fringilla orci, eget tincidunt tellus. Mauris id egestas sem. Proin
dapibus maximus orci ut lacinia. Quisque gravida ex et diam venenatis, nec lacinia tellus porta.

* Duis consequat quis ipsum ac interdum etiam tempus fermentum imperdiet.

» Curabitur omare dapibus lorem euismod egestas cras euismod bibendum felis, quis porta nisl semper in,

curabitur rutrum nulla quis purus finibus tristique.

Tip: You can also use the Format Painter button
on the Clipboard menu to copy the necessary text
formatting. First, select an area of text that has the
correct style, then click the Format Painter button, i

Past —
and then select the area of text you want to af

change. It will be converted to the correct style. Clipboara

2. Now, select some text with the wrong style (need to change) and

press Ctrl+Shift+V or Cmd+Shift+V.

JULIET ROWSE

PROFESSIONAL JOB TITLE

+012-345-6789 | name surname@gmail.com | New York, NY | linkedin.com/in/name surname

e SUMMARY
Lorem ipsum dolor sit amet, consectetur adipiscing elit. Cras eu tellus et enim ornare
feugiat id id lacus. Integer at euismod erat. Nullam semper ante nec tempus pretium. Sed
nisi lacus, blandit at scelerisque nec, imperdiet non diam. Proin ut jaculis massa. Nulla non odio pharetra,
gravida nunc eu, laoreet tortor. Donec vel risus metus. Nulla sem orei, sollicitudin sed mauris eu, enismod
mollis erat.

PROFESSIONAL SKILLS

| Communication | Negotiation | Collaboration | Build Relationship | Coaching | Market Knowledge |
| Sales Planning | Develop Budgets | Analytics | Meeting Sales Goals |

3. Now, the text has reached the desired appearance.

JULIET ROWSE

PROFESSIONAL JOB TITLE

+012-345-6789 | name sumame@gmail.com | New York, NY | linkedin.com/in/name.surname

e SUMMARY

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Cras eu tellus et enim ornare feugiat id id lacus. Integer at

euismod erat. Nullam semper ante nec tempus pretium. Sed nisi lacus, blandit at scelerisque nec, imperdiet non

diam. Proin ut iaculis massa. Nulla non odio pharetra, gravida nunc eu, laoreet tortor. Donec vel risus metus. Nulla|
sem orci, sollicitudin sed mauris eu, euismod mollis erat.

PROFESSIONAL SKILLS

| Communication | Negotiation | Collaboration | Build Relationship | Coaching | Market Knowledge |
| Sales Planning | Develop Budgets | Analytics | Meeting Sales Goals |




Text Formatting

To change the font, color or size, you can use the Font Settings menu on the Home tab.

1. Select the desired text, and then choose the desired font color. 3. Select the desired text, and then select the desired font size.
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2. Select the desired text, and then choose another font.
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Text Formatting

If you find that 1-2 lines of text have moved to the next page during the template filling process, you can do three things to avoid this situation:

1.Change the font size of the main text (please refer to the previous page)
2.Change the line spacing (please refer to the instructions on this page)

3.Change the margins of the page (please refer to the instructions on the next page)

You can use all these methods at the same time.

1. Select the desired paragraph, and then press the small arrow in the
lower right corner of Paragraph Settings. You will access the

Paragraph dialog box.
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diam. Proin ut iaculis massa. Nulla non odio pharetra, gravida nunc eu, laoreet tortor. Donec vel risus metus. Nulla

sem orci, sollicitudin sed mauris eu, euismod mollis erat

PROFESSIONAL SKILLS

|C V| n | C 1 | Bui
| Sales Planning | Develop Budgets |

WORK EXP

Position Title Here

Company, Location

Proin a magna condimentum eros feugiat iaculis. Interdum
Aliquam auctor leo id ultrices euismod. Etiam eget fringilla
dapibus maximus orci ut lacinia. Quisque gravida ex et dial
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« Curabitur omare dapibus lorem euismod egestas cf
‘curabitur rutrum nulla quis purus finibus tristique.

« Ut convallis eu tortor eu elementum, interdum et
consectetur bibendum tellus, sit amet tincidunt dol:i
pellentesque suscipit orci, aliquam in nunc ante.

+ Aliquam erat volutpat duis at nunc at arcu convallis

« In laoreet quam sit amet nulla consequat maximu
massa.

Position Title Here
Company, Location
Vivamus at quam non odio finibus aliquet. Praesent maxim)
sit amet mauris tristique sem bibendum venenatis sed sit 4
« Nullam sodales velit a urna lacinia, quis tincidunt orc
« Nullam placerat risus at massa porta mollis d
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2. Here, you can choose to adjust
the spacing between lines in the
document. Select Multiple and
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3. You can also adjust the space
before and after the paragraph.



Margins

Margin is the empty area between the text and the edge of the document. Sometimes you need to change the margins.
Please follow the following steps:

1. Select the Layout tab, and then click the Margins command. 2. The page setup dialog box will appear. In it you can adjust the
Choose Custom Margins from the drop-down menu. value of each margin.
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Shading / Adding Lines

If you would like to customize your resume format and alter the shading or add lines after the text, follow the steps below.

1. Select the desired text, then click the Shading button on the
Paragraph Settings menu, and then select the color.
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2. To add a horizontal line, place the cursor on the desired position on
the page, and then find the Border button on the Paragraph Settings
menu, and then select Bottom Border or Top Border.

E resume_example.docx - Wol

Mailings  Review Grammarly ~ Acrobat  ePUBTools

T | aabeene| asBbcede AaBbC( AaBbCcl
e Normal | TNo Spac.. Heading1  Heading 2

ormat Painter | -
2ard w Font 5 Paragraph 2 Bottom Border
C 4 Top Border 6 - . -, . . .

[+7 Left Border
Right Border
No Border

[ Outside Borders
PROFESSIONAL JOB  InsideBorders

£ Inside Horizontal Border

[ Inside Vertical Border
+012-345-6789 | name.surname@gmail.com | New York, I surname

4= Horizontal Line

»

SN T Draw Table

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Cras eu tellus E View Gridiines {lacus. Integer at
euismod erat. Nullam semper ante nec tempus pretium. Sed nisi lact [} Borders and Shading..  2¢, imperdiet non
diam. Proin ut iaculis massa. Nulla non odio pharetra, gravida nunc eu, laoreet tortor. Uonec vel risus metus. Nulla
sem orci, sollicitudin sed mauris eu, euismod mollis erat.




Adding Pages

If you need to add additional pages, you can do it one of two ways:

1. Place the cursor at the bottom of the final page and press Enter.
The new page will automatically show up.

2. Another method is to click the Blank Page button in the Insert tab.
A new page will appear every time you click.
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JULIET ROW

PROFESSIONAL JOB TIT

+012-345-6769 | name surname@gmailcom | New York, NY | i

SUMMARY

L orern ipsum dolor sit amet, conseciatur adipiscing elit Cras eu tellus et eni

3. Now, you need to copy the content on the last page. Select the
entire page and press Ctrl+C or Cmd+C. Then point the cursor to the
new page and press Ctrl+V or Cmd+V




Show/Hide Function

For ATS-compatible resumes, it is crucial to avoid extra spaces between potential keywords. If the words are separated by extra spaces, the top ATS will
not even recognize multi-word keywords. A simple solution is possible: Before submitting, please double check your spacing, especially the spacing

between multi-word keywords.
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a PROFESSIONAL-JOB-TITLEY
T

+012-345-6789 | -name.sumame@gmail.com- |- ‘New-York, NY-|-linkedin.com/in/name.surname
1
1
SUMMARYY

T
Lorem-ipsum-dolor-sit-amet, consectetur-adipiscing-elit. Cras eu tellus-et-enim-ornare feugiat-id-id lacus.-Integer-at

euismod-erat.-Nullam-semper-ante-nec-tempus-pretium_-Sed nisi-lacus, ‘blandit-at-scelerisque-nec, imperdiet-non
diam.-Proin-ut-iaculis massa. Nulla-non-odio-pharetra, -gravida-nunc-eu, laoreet tortor.-Donec-vel risus metus.-Nulla

2. Check the full text and delete the extra spaces (if found). Generally, if you sem-orci, solicitudin sed mauris-ou, euismod molls. orat 7
see more than one dot between words, please delete the extra part. il

1
Position TitleHere@- e 08/2019._.Present1|'

Company,-Locationq|

1
Proin-a-magna-condimentum-eros-feugiat-iaculis.-Interd ‘malesuada-fames-ac-ante-ipsum-primis-in-faucibus.-

e Aliguam-auctor-leo-id-ultrices-euismod.-Etiam-ege get-tincidunt-tellus.-Mauris-id-egestas-sem.-Proin-
dapibus-maximus-orci-ut-lacinia.-Quisque-gravida-ex-et-diam-venenatis,-nec-lacinia-tellus-porta.q|

.4Duis-consequat-quis-ipsum-ac-iempus-fermentum-imperdiet.-11

o~ Curabitur-ornare-dapibus-lorem-euismod-egestas- cras-euismod-bibendum-felis,-quis-porta-nisl- semper-in,-
curabitur-rutrum-nulla-quis-purus-finibus-tristique.q|

3. After completing the checking process, just click the Show/Hide button again to hide the text formatting symbols. Or press Ctrl+Shift+8 or
Cmd+Shift+8 again.



Saving Your Resume

The most common resume format is PDF. It is important to give your resume a correct name.

Choose the next option: Name-Position-Title-Document. It looks like Juliet Rose-Assistant-Manager-Resume.pdf. If the post is too long, you may lose it in
the file name. (Juliet-Rowse-Resume.pdf). In addition, always use hyphens or underscores to separate words and capitalize the first letter.

The following are instructions on how to save the file as a PDF document.

1. Click File, and then click Save As. Select This PC and choose 2. Enter the file name, select the PDF type, and then click Save.
your preferred location.
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Tip: Usually, you can choose to submit a cover letter and provide a reference letter upon request.
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Useful Keyboard Shortcuts

Save the document — Ctrl+S or Cmd+S Undo the previous action — Ctrl+Z or Cmd+2Z

Copy the selected content — Ctrl+C or Cmd+C Redo the previous action, if possible — Ctrl+Y or Cmd+Y

Cut the selected content — Ctrl+X or Cmd+X Copy the selected formatting — Ctrl+Shift+C or Cmd+Shift+C

Paste the content — Ctrl+V or Cmd+V Paste the selected formatting — Ctrl+Shift+V or Cmd+Shift+V

Select all document content — Ctrl+A or Cmd+A Switch the text between upper case, lower case, and title case — Shift+F3
Decrease the font size by 1 point — Ctrl+[ or Cmd+[ Display all nonprinting characters — Ctrl+Shift+8 or Cmd+Shift+8

Increase the font size by 1 point — Ctrl+] or Cmd+]

N



